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(2)  The contents of this documentation are subject to change without notice. 
(3)  Comments and notification of any mistakes in this documentation are gratefully 

accepted. 
(4)  This software cannot be used with other equipment that the specified. 
(5)  EPSON will not be responsible for any consequences resulting from the use of any 

information in this documentation. 
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Section 1.  Introduction 

This manual contains an outline of the EPSON OPOS ADK program and provides 
installation and setup instructions for the OPOS Setup program.  
 
EPSON OPOS ADK contains software with API functions that can be used easily through 
ActiveX controls supported by Visual Basic on the using OS platforms. Application 
developers without any concern for attached peripherals type or protocol, can develop 
real-time, multitasking, GUI-based, POS applications with lots of functionality. 
 
Section 2, Development Outline, describes the requirements and uses of EPSON OPOS 
ADK, and lists what is included in the package. 
 
Section 3, SetupPOS Utility, describes how to use the program to record information about 
OPOS devices in the system registry. 
 
Section 4, Warnings, describes the matters that demand attention. 
 
The “UPOS Specification”, created by the OPOS committee, describes API functions in 
detail. The Application Development Guide describes application development. Please 
refer to these manuals for information on these subjects. 
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Section 2.  Development Outline 

This section describes development outline for the EPSON OPOS ADK. 
 
2.1 Features 

EPSON OPOS ADK offers standardized API functions that interface with 
peripherals used in POS systems through ActiveX controls that can be run in 
Visual Basic, operating on the using OS platforms. Through these standardized 
API functions, you can develop powerful, open POS systems easily. 

 
2.2 Operating Environment 

The EPSON OPOS ADK operates under the following environment. 
 
• Computer Hardware 

IBM PC/AT or compatible 
* Please follow the specifications recommended by your OS for system 

requirements (CPU, RAM, etc.). 
* At least 60M bytes hard disk capacity is needed except for 

recommended blank capacity of using OS. 
 

• Operating Systems 
For details, please refer to Release notes (“Relnote.txt”) . 
 

• Accessible Serial Ports 
COM1, COM2, COM3, COM4 (extended port functions allow use of 
COM5 though COM10) 
 

• Accessible Parallel Ports 
LPT1, LPT2, LPT3 (operation is unverified in LPT3) 
 

• Accessible USB ports 
USB equipment must be connected to the IBM PC/AT compatible 
machines that are equipped with USB connectors or use USB expansion 
cards. 
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• Accessible Network 
Ethernet and IEEE802.11 support applies to TCP/IP compliant networks.  
 

• Accessible Bluetooth 
When using a Bluetooth connection, please use the standard Windows 
Bluetooth stack. 
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Section 3.  SetupPOS Utility 

SetupPOS is a setup utility for registering, modifying, or deleting devices and port 
environments of EPSON OPOS ADK to the system registry. 
Depending on the permissions of the user, the user may only be able to view the settings 
but does not have the ability to register or modify the settings without a few exceptions. 
 
3.1 Starting 
3.1.1 Starting SetupPOS 

From the Windows OS Start menu, select Epson OPOS ADK > EPSON OPOS 
ADK SetupPOS and launch it.  
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3.2 Basic Operations (MAIN WINDOW) 
When SetupPOS runs, its main window appears as shown below. In this window, 
it is possible to add or delete devices, and make the settings by the explorer-like 
operations.  

 

 

The following sections describe each item one by one. 
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3.2.1 Menu 
1. File 

This menu contains commands to display properties and exit SetupPOS. 
 
i. Property 

Use this menu command to display properties of the item selected in the 
left or right pane. The properties can only be viewed but not modified. 

ii. Exit 
Use this menu command exits SetupPOS. 

 
2. Edit 

This menu contains commands for setting and editing devices. 
 
i. Add New Device 

Use this menu command to display the Add Device wizard and add a 
new device to the device class. The device class displayed here refers to 
devices prepared by the install program. For details, refer to "3.3.1 Add 
Device Wizard" in this manual.  
The user must have the administrative permissions to use this function. 

 
ii. Add Logical Device Name 

Use this menu command to display the “Add Logical Device Name” 
dialog box and add a logical device name to a device. A logical device 
name that has already been used by the same device class cannot be 
specified. 
The user must have the administrative permissions to use this function. 
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<About the dialog box for adding logical device name> 
"DeviceClass" drop-down list 
Select a device class for adding the logical device name. If the device 
class has already been selected in the window, then it appears in the 
drop-down list by default. Also, only device classes which the control 
objects (CO) supporting the device is installed are listed in the drop-down 
list. 
 
"Device name key" drop-down list 
Select a device name key for adding the logical device name. If the 
device name key has already been selected in the window, then it 
appears in the drop-down list by default. If no device exists for the device 
class, then the drop-down list becomes empty. 
 
"Logical device name" edit field 
Enter a logical device name to be added. The name can be up to 255 
characters, but it cannot contain the "\” character. If the logical device 
name is invalid or is already registered, then the Continue or the [OK] 
button becomes disabled. 
 
[Continue] button 
Use this button to set up the logical device name and then continue to 
add more logical device names. 
 
Adding a logical device name 
In the window, select a device name key for adding the logical device. 
From the Edit menu, select "Add New Logical Device Name " and then 
enter the logical device name. Another method is to select a device name 
key for adding the logical device and right-click it. From the pop-up menu, 
select "Add New Logical Device Name " and then enter the logical device 
name. 
 

iii. Delete 
Use this menu command to delete a device selected in the current 
window. Before deleting, a confirmation message box appears; when 
clicking the [Yes] button, the device is deleted. 
When deleting a Primary device of Hydra connection, a confirmation 
message box appears that is whether to delete the Secondary devices as 
well. It is possible to select to delete the Primary device only or all 
including the Secondary devices. 
 
To delete a device, use one of the following methods: 
1) In the main window, select a device name key or the LDN to be 

deleted. From the Edit menu, select Delete. 
Or, in the main window, select a device name key or the LDN to be 
deleted. Right-click to bring up a pop-up menu and select Delete. 

2) In the main window, select a device or the LDN to be deleted, and 
then press the Delete key. 

3) In the main window, select a device or the LDN to be deleted, and 
then click the [Delete] icon in the tool bar. 
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iv. Rename Logical Device Name 
Use this menu command to rename the logical device currently selected 
in the window. The name can be up to 255 characters, but it cannot 
contain the "\" character. Also, the same logical device name cannot be 
used again in the same device class. 
 
The user must have the administrative permissions to use this function. 
 
To rename a logical device: 
While in the main window, select a device name. From the Edit menu, 
select “Rename Logical Device Name”. The name is ready for editing 
now. Change the device's name and then press the Enter key. 
 

v. Communication Setting 
Use this menu command to display the “Communication Setting” dialog 
box and change the communication settings of the selected device. This 
function works only on the EPSON devices. 
Communication Setting of Secondary devices with Hydra connection 
cannot be modified. Also, Communication Setting of device with Hydra 
connection can only be performed from the Primary device. When the 
Primary device is changed, settings of all of its Secondary devices are 
changed as well. 
The user must have the administrative permissions to use this function. 
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3. View 
Use this menu to control display of the main window. 
 
i. Toolbar 

Use this menu command to hide or display the tool bar. 
 

With a check mark : The tool bar is displayed. 
With no check mark : The tool bar is hidden. 

 
Once changed, the setting remains effective even when restarting the 
system. As the default, the tool bar is displayed. 
 
What is the tool bar? 
The tool bar appears below the menu bar of the main window and 
contains a list of frequently used menu commands. Clicking a button 
easily run a menu command associated with the button. 
 

ii. Status Bar 
Use this menu command to hide or display the status bar. 
 

With a check mark : The status bar is displayed. 
With no check mark : The status bar is hidden. 

 
Once changed, the setting remains effective even when restarting the 
system. As the default, the status bar is displayed. 
 
What is the status bar? 
The status bar displays various information of the main window. For 
example, when a menu bar item is displayed, its description appears on 
the status bar. 
 

iii. Large Icons 
Use this menu command to display items in the right pane in large icons. 
It is possible to display information using one of the following menu 
commands: [Large Icons], [Small Icons], [List], or [Details]. When 
selecting [Large Icon], a check mark appears together with the command. 
Once selected, the setting remains effective even when restarting the 
system. 
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iv. Small Icons 
Use this menu command to display items in the right pane in small icons. 
It is possible to display information using one of the following menu 
commands: [Large Icons], [Small Icons], [List], or [Details]. When 
selecting [Small Icon], a check mark appears together with the command. 
Once selected, the setting remains effective even when restarting the 
system. 
 

v. List 
Use this menu command to display items in the right pane as a list. It is 
possible to display information using one of the following menu 
commands: [Large Icons], [Small Icons], [List], or [Details]. When 
selecting [List], a check mark appears together with the command. Once 
selected, the setting remains effective even when restarting the system. 
As the default, items in the right pane are displayed as a list. 
 

vi. Details 
Use this menu command to display items in the right pane as a detailed 
list. In the Details view, "Device " and "Connection information" are 
displayed. It is possible to display information using one of the following 
menu commands: [Large Icons], [Small Icons], [List], or [Details]. When 
selecting [Details], a check mark appears together with the command. 
Once selected, the setting remains effective even when restarting the 
system. 
 

vii. View by Port 
Use this menu command to change the display of devices in the left 
window. If “View by Port” is selected, devices in the left window will be 
displayed by the connected port. If the checkbox is not selected, devices 
in the left window will be displayed by device class. When “View by Port” 
is selected, a checkmark will appear. Once set, the setting remains 
effective even when restarting the system. 
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viii. Sort by Name 
Use this menu command to change the sort order of the device classes 
in "Sort by Name". If " Sort by Name " is selected, then device classes 
are sorted alphabetically. If the checkbox is not selected, then device 
classes supported by EPSON have the priority in the display. Once set, 
the setting remains effective even when restarting the system. 
 

ix. View Available only 
Use this menu command to display only the device classes supported by 
EPSON OPOS ADK. By default, this checkbox is checked. Once set, the 
setting remains effective even when restarting the system. 
 

x. View all 
Use this menu command to expand the view of the left pane. After 
selecting “View all”, all device information is not always displayed, but 
right after “View all” is selected. Using this menu command enables to 
check the details of the device currently set. 
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4.  Tool 
Use this menu to display items for supplementary tools of devices. 
 
i. Interactive CheckHealth 

This menu command calls the CheckHealth method using Level = 
OPOS_CH_INTERACTIVE for the device (key of the device name) 
currently selected in the window. If the call succeeds, the result is 
displayed in CheckHealthText. If error occurs during the call, then an 
error API is called, and ResultCode and ResultCodeExtended are 
displayed. 
This menu command becomes disabled if no device name key is 
selected in the window. 
 
What is " Interactive CheckHealth (OPOS_CH_INTERACTIVE)"? 
Interactive CheckHealth executes an interactive test with device. The 
supported service object usually provides a dialog box to display the test 
options as well as test results. 
 

ii. Device Specific Settings 
Use this menu command to perform device specific settings for the 
device currently selected in the window. If no device name key is 
selected in the window, then this operation becomes disabled. Also, if the 
selected device does not support device specific settings, then this 
operation becomes disabled. 
The user must have the administrative permissions to use this function. 
 

iii. Export Registry 
Use this menu command to display the “Export Registry” dialog box and 
export the current OPOS registry settings to a registry data file. The 
saved file can then be used to recover, copy, or install the OPOS 
environment. 
In the “Save As” dialog box, specify a file name to export the registry. If 
the file already exists, then a message box appears to confirm to 
overwrite the existing file. Select the [Yes] button to overwrite, or the [No] 
button to append. If the existing file is overwritten, then all existing 
registry data is deleted; if the existing file is appended, then the new 
settings are appended to the end of the file. It is possible to specify the 
extent of the export from the following options: Register All, Selecting 
Object, and Hydra. 



Version 3.00 
 

 

<Export registry dialog box> 
[All] button 
Use this button to export all OPOS registry settings to a registry data file. 
All settings below the ADK configuration key of the registry are always 
saved. 
 
[Selected] button 
Use this button to export only the OPOS registry settings for the item 
currently selected in the window, to a registry data file. If multiple items 
are selected, then multiple registry settings are exported. This button 
becomes disabled if no item with registry settings is selected in the 
window. 
 
[Hydra] button 
This button becomes enabled if the device currently selected in the 
window is a Hydra device, and then the Hydra-related settings of the 
device are exported. This button becomes disabled if the device currently 
selected in the window is not a Hydra device. 

 
5. Option 

This menu contains commands for maintenance. 
 
i.  Confirm the Hydra Setting closely 

Use this menu command to add devices of the same device class to the 
same port and to build multiple hydra configurations. 
 

If checked : Hydra settings will be checked strictly. 
If unchecked : Only minimal checking will be performed. 

 
The user must have the administrative permissions to use this function. 
 

ii. Port Range Settings 
Use this menu command to display the ”Port Range Settings” dialog box 
and set the maximum numbers of the serial or parallel ports according to 
the hardware configuration. Usually, if the port configuration is not 
changed, it is not necessary to use this dialog box. The default range 
depends on the PC, but the acceptable range are as follows: 
 

COM port : 10 
LPT port : 3 

 
The user must have the administrative permissions to use this function. 
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<Port range dialog box> 
"Maximum COM ports" edit field with spin buttons 
Set the largest number of serial (COM) ports that can be used. The range 
that can be chosen is 1 to 10. 
 
[Default value] button 
 
Use this button to set the default value (10) as the maximum number of 
serial (COM) ports. 
"Maximum LPT ports" edit field 
Set the largest number of parallel (LPT) ports that can be used. The 
range that can be chosen is 1 to 3. 
 
[Default value]  button 
Use this button to set the default value (3) as the maximum number of 
parallel (LPT) ports. 
 

iii. OPOS API Trace Settings 
Use this menu command to display the “OPOS API trace settings” dialog 
box and set the trace settings of OPOS ADK. Note that for version 1.xx, 
the trace function can be used only if an EPSON OPOS ADK supporting 
trace is installed. 
The trace (log) function provides support for application development. 
Usually, this function is used only for debugging OPOS applications; it is 
not used for other purposes. 
The user must have the administrative permissions to use this function. 
 

<OPOS API Trace setting dialog box> 
[Tracing mode] radio buttons 
Select a tracing mode from the following options: 
 

"No Trace" : Disable the OPOS API trace function. 
This option is selected as the default. 

"Global Trace" : Trace all OPOS devices (EPSON devices only). 
"Private Trace" : Trace only the specified valid device(EPSON 

devices). 
 
Usually, select "No Trace". 
When the OPOS API trace is turned on, all OPOS API calls (all property 
access and all method calls) are traced, with the trace result recorded in 
the trace log file. Note that the "Global Trace" option takes priority over 
the "Private Trace" option, but when the "Private Trace" option is used, 
the "Global Trace" settings are deleted. For example, if "Global Trace" 
has been set to the POS printer and the user uses the line display to set 
trace to "Private Trace", the POS printer will be excluded from the target 
of trace. 
To avoid this problem, use the "Private Trace" option for the device to 
trace. 
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"Device" drop-down list 
Use this drop-down list to specify the device name for which the OPOS 
API trace function will be enabled when [Private Trace] is selected. 
 
"Enable trace of selected device" checkbox 
Use this checkbox to enable the OPOS API trace function for the 
selected device. 
 
"Trace log file path" edit field 
Use this edit field to specify a specific trace log file. When cleared, the 
trace log file name is automatically set. 
 
If a special trace log file is specified, please be careful of the access 
privileges for both the specified file, and for the save location. 
If there is an insufficient access privilege for the specified location, the 
trace log file will not be created. 
 
"Notify when trace log file becomes full " checkbox 
To receive notification when the trace log file has exceeded the 
maximum size, select this checkbox. 
 

iv. Sleep Time Settings 
Use this menu command to display the “Sleep Time Settings” dialog box 
and set the Sleep time of Win32 API. 
In the programs for waiting for input from device inside the driver or long 
processing programs, to keep the CPU time use exclusively, EPSON 
OPOS ADK calls Sleep (a WIN32 API) and specifies the time to pass 
control to other programs. 
By using this dialog box, it is possible to set the length of the Sleep time 
for processing long programs. 
By modifying the sleep time, it is possible to change the ratio of the CPU 
time used by a particular device. For the sleep time of input-waiting 
programs, refer to the port details of the device to learn to how to change 
it. Because the settings have been optimized, usually it is not necessary 
to modify them. 
The user must have the administrative permissions to use this function. 
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<Sleep Time Settings dialog box> 
"Device" drop-down list 
Use this drop-down list to select a device for setting the sleep time. 
If a device name is currently selected in the window, the device appears 
as the default name in the drop-down list. 
To change the sleep time of the other device, select the device name 
from the list. 
 
"Setting value (msec)" edit field 
Use the edit field to specify the sleep time for the Sleep API. The 
acceptable range is 0 to 999. 
 

v. Operation Settings 
Use this menu command to display the “Operation Settings” dialog box 
and set the Message Handing, Version Compatibility and Communication 
Capability. 
 
Message handling 
"Message is processed during synchronous" check box 
Enables/disables compatibility of message processing to be executed 
during synchronization when this checkbox is selected. 
By default, this checkbox is unchecked. 
 
What is message handling? 
Some application needs to extract a message while a method requiring 
much time is being processed. In this case, use this command. If 
"Message is processed during synchronous" is selected, then OPOS 
methods or properties are not executed while an OPOS method requiring 
much time is being processed. 
(For example, during synchronization, if the Close method is executed, 
this may result in fatal errors such as causing the PC to hang.) 
 
Version compatibility 
"Enable OPOS Ver2.50 compatibility" check box 
Enables/disables compatibility of the ‘initialization process,’ ‘Hydra error 
code switching,’ and ‘error event processing’ to operate according to the 
specifications of EPSON OPOS ADK Ver2.50 or earlier. 
By default, this checkbox is unchecked. 
 
Communication compatibility 
"Use operations in serial connection for USB connection" check 
box 
Enables/disables compatibility of USB connection and serial connection 
communication. If this checkbox is selected when a device is connected 
by USB, operation will be equivalent to a serial connection. When a 
device that has been used in a serial connection is changed to a USB 
connection, this allows you to use the device without changing the 
application. 
By default, this checkbox is unchecked. 
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6. Help 
This menu contains commands on help. 
 
i. Help Topics 

Use this menu command to search help by topic and keyword. 
 

ii. About 
Use this menu command to display the version information dialog box 
and view the EPSON OPOS ADK, control object information (CO) as well 
as the version information of SetupPOS. 
 

<About SetupPOS dialog box> 
The version and copyright of the SetupPOS utility are displayed in this dialog 
box. 
 
* EPSON OPOS ADK version 

"EPSON OPOS ADK version" edit field 
The version of EPSON OPOS ADK appears in the edit field. 
 

* Version information of control object 
If multiple CO exists, then the version information of the CO found first is 
displayed. 
 
"Device class" drop-down list 
Use this drop-down list to select a device class for display of the version 
information of a control object. 
 
"Version number" edit field 
The version information of a control object appears in the format of 
"X.Y.Z". 
 
"Description" edit field 
Description of the control object appears in the edit filed. 
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3.2.2 Tool Bar 
It is possible to operate the main function of the menu bar by clicking a button. 
The following tool bar buttons are available: 
For the function, refer to the appropriate explanation of the menu bar. 

1.  Add device 

2.  Add logical device name 

3.  Delete 

4.  Interactive CheckHealth 

5.  Device specific 

6.  Communication setting 

7.  Property 

8.  Large Icons 

9.  Small Icons 

10.  List 

11.  Details 

12.  Help 

3.2.3 Left Pane 
The left pane of the window displays a tree structure of devices. 

• From the View menu, it is possible to select "Device Class View" or "Port 
Connection View" to change the way devices are displayed. 

• Menu commands can be applied to a selected item on the tree structure. 

• The pop-up menu can be used with each item. 

• The user must have the administrative permissions in order to modify the 
settings. 
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3.2.4 Right Pane 
The right window displays the detailed information on the selected item in the left 
window. 
 

(1). "Device Class View" 

• Device class appears below "Device". 

• Device name key for each device appears beneath the device. 

• When selecting a device name key in the left pane, the logical device name 
which belongs to that device appears in the right pane. Note that logical 
device names always appear in the right pane; they never appear in the left 
pane. 

• A device class is also displayed even if any corresponding device is 
registered. 
However, icons of installed devices not from EPSON are dimmed. 
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(2). "Port Connection View" 

• The port type appears below "Port". 

• Below the port type, port names (only those which can be set) are 
displayed. 

• Device name key for each device is displayed below each port name. 

 
What is COM? 
It displays devices connected to the serial port. 
 
What is LPT? 
It displays devices connected to the parallel port. 
 
What is USB? 
It displays devices connected to the USB port. 
 
What is Network? 
It displays devices connected through Ethernet. 
 
What is Bluetooth? 
It displays devices connected through Bluetooth. 
 
What is "(None)" 
It displays devices with undefined port settings. 
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3.2.5 Pop-up Menus 
Items in the left and right panes of the window support pop-up menus. 
What is a pop-up menu? 
When clicking an item and then right-clicking the mouse, a menu appears. This 
menu is a pop-up menu. 
The following pop-up menus are available to items selected in the window. 
 

Selected Item Pop-up Menu Description 
Device Add New Device Use this menu command to display the 

“Add Device” wizard. 
Export Registry Use this menu command to display the 

“Export registry” dialog box. 
class name Add New Device Use this menu command to display the 

“Add Device” wizard. 
Export Registry Use this menu command to display the 

“Export registry” dialog box. 
Device name key Interactive CheckHealth Use this menu command to start 

interactive CheckHealth. 
Device Specific Settings Use this menu command to display the 

“Device Specific Settings” dialog box. 
If the selected device does not support 
device specific settings, then this 
command is disabled. 

Add Logical Device Name Use this menu command to display the 
“Add logical device name” dialog box. 
The key to the selected device name 
appears as the default. 

Communication Settings Use this menu command to display the 
“Communication Settings” dialog box. 
If the selected device is not from 
EPSON, then this command is 
disabled. 

Delete Use this menu command to delete a 
device. 

Export Registry Use this menu command to display the 
“Export registry” dialog box. 

Property Use this menu command to display the 
following setting tabs: "Details 
information", " Communication 
setting", "Other setting". 

Logical device name Add Logical Device Name Use this menu command to add the 
logical device name. 

Delete Use this menu command to delete the 
logical device name. 

Rename Logical Device 
Name 

Use this menu command to change 
the mode to the edit mode for 
modifying the logical device name. 
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3.3 Using Wizards 
3.3.1 Using the  Add Device wizard 

This wizard adds devices and performs communication settings. Follow the 
instructions on the screen to perform the operations. 
 

3.3.1.1 Device Class Selection Screen 
In this screen, select a device class to be added. 

 

If a device class has been already selected in the main window before starting this 
wizard, this screen does not appear; instead, the next screen will appear. 
 
"Device Class" list box 
Use this list box to display a list of device classes to be selected. Click to select the 
device class of a device to be added. 
Note that the list displays only device classes that are installed control object (CO) 
that supports the device. 
If the necessary device classes are not listed in the list, re-install OPOS ADK, or 
update it to the appropriate version. 
 
[Next] button 
Use this button to move to the device selection screen. 
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3.3.1.2 Device Selection Screen 

In this screen, set the details of the device to add. 

 

"Device" drop-down list 
Use this drop-down list to display a list of selectable devices and select a device 
from the list. When the selected device has multiple connection types, select the 
appropriate type on the right under [Connection]. 
 
"Connection" drop-down list  
Use this drop-down list to connection type for the device. 
The available connection types differ based on the device class and the specific 
device. 
 
For POSPrinter, some devices support only TMPORT, while others allow selection 
from COM, LPT, USB, or Network, depending on what the device supports. 
 
For LineDisplay, you can choose the appropriate connection type based on the 
actual connection method from Printer Connection, Standalone, or Pass-through, 
depending on the supported options of the selected device. 
 
For CashDrawer and Scanner, only Printer Connection is available, and for 
ElectronicJournal, only TMPORT is supported. 
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"Name" edit field 
The name of the device selected under [Device] is displayed. 
The displayed device name may change depending on the connection type. 
 
"Description" edit field 
This edits field displays description of the device selected in the "Device" list. 
 
"Add LDN(Logical Device Name)" edit field 
Enter a logical device name for the selected device. 
The name can be up to 255 characters, but it cannot contain the "\" character. 
In addition, the same logical device name cannot be used again in the same 
device class. 
If the logical device name is invalid, then the [Next] button appears dimmed, and it 
is impossible to proceed to the next step. 

 
3.3.1.3 Select connection device 

In this screen, select the connection condition and connection device. 
The connection type and/or connected device must be selected when registering a 
LineDisplay or Cashdrawer. 
 

 
 
"Device" drop-down list 
Use this drop-down list to display a list of selectable devices and select a device 
from the list. When the selected device has multiple connection types, select the 
appropriate type on the right under [Connection]. 
 
"Connection" drop-down list  
Use this drop-down list to connection type for the device. 
The available connection types differ based on the device class and the specific 
device. 
 
"Name" edit field 
The name of the device selected under [Device] is displayed. 
The displayed device name may change depending on the connection type. 
 
"Description" edit field 
This edits field displays description of the device selected in the "Device" list. 
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3.1.1.3 Communication Settings Screen 
In this screen, set a port to connect and its details. 
 
Port Setting (for serial, parallel, or USB)  

 
 
Port Setting 
"Port number" drop-down list 
Depending on the type of port of the selected device, the following drop-down list 
are available. 

For serial port :  “COM Port Settings”  
For parallel port :  “LPT Port Settings”  
For USB port :  “USB Port Settings” 

From the drop-down list, select a port number for the serial, parallel, or USB port. 
If "None" is selected, then the port settings will be deleted. 
For serial and parallel ports, it is possible to use the port range dialog box to 
change their port ranges. 
For USB port, when the communication settings screen appears, all the USB 
driver's connectable ports become the selectable range. 
 
"Port is being used by" drop-down list 
Use this drop-down list to display a list of devices that has been already set up for 
the selected port number. 
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Detailed Setting 
"Baud rate" drop-down list 
Use this drop-down list to display and select the communication speed for the 
serial port. 
The values that can be used limited to the supported values of the device. 
For details, refer to the hardware manual of the device. 
If the port selection is parallel, USB, or "None", then this drop-down list cannot be 
used to change the setting. 
 
"Bit length" drop-down list 
Use this drop-down list to display and select the data bit length of the serial port. 
The values that can be used limited to the supported values of the device. 
For details, refer to the hardware manual of the device. 
If the port selection is parallel, USB, or "None", then this drop-down list cannot be 
used to change the setting. 
 
"Parity" drop-down list 
Use this drop-down list to display and select the parity bit of the serial port. 
The values that can be used limited to the supported values of the device. 
For details, refer to the hardware manual of the device. 
If the port selection is parallel, USB, or "None", then this drop-down list cannot be 
used to change the setting. 
 
"Stop bit" drop-down list 
Use this drop-down list to display and select the stop bit of the serial port. 
The values that can be used limited to the supported values of the device. 
For details, refer to the hardware manual of the device. 
If the port selection is parallel, USB, or "None", then this drop-down list cannot be 
used to change the setting. 
 
"Hand shaking" drop-down list 
Use this drop-down list to display and select the handshake type of the serial port. 
The values that can be used limited to the supported values of the device. 
For details, refer to the hardware manual of the device. 
If the port selection is parallel, USB, or "None", then this drop-down list cannot be 
used to change the setting. 
 
"Input buffer" edit field 
This edits field supports only Version 1.xx devices. 
Use this edit field to display and set the input buffer size of the serial port. 
The acceptable range is 32 to 8192. 
For details, refer to the hardware manual of the device. 
If the port selection is parallel, USB, or "None", then this edit field cannot be used 
to change the setting. 
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"Output buffer" edit field 
Use this edit field to display and set the output buffer size of the serial or parallel 
port. 
The acceptable range is 32 to 1024, but restrictions apply to some devices... 
This setting is valid for parallel port, and it is possible to specify the size of data to 
output. 
For details, refer to the hardware manual of the device. 
If the port selection is USB or "None", then this edit field cannot be used to change 
the setting. 
 
"Output interval time" edit field 
Use this edit field for set the retry time to use when output fails. For details of 
output interval time, please refer to the "3.7 Glossary" of this manual. The 
acceptable range is 0 to 9999. For details, refer to the hardware manual of the 
device. 
If the port setting is "None", this field cannot be used to change the setting. 
 
"Input sleep time" edit field 
This edits field supports only Version 1.xx devices. 
Use this edit field to display and set the sleep time to use by the Sleep API in input. 
The acceptable range is 0 to 99. 
For details, refer to the hardware manual of the device. 
If the port selection is USB or "None", then this edit field cannot be used to change 
the setting. 
 
[Interactive CheckHealth] button 
Use this button to call the CheckHealth method for the selected device using Level 
= OPOS_CH_INTERACTIVE. 
If the port setting is "None", then this button is disabled and afterwards interactive 
CheckHealth is not executed. 
 
[Device specific setting] button 
Use this button to display the "Device Specific Settings" dialog box and change 
the device specific settings for the selected device. 
If the port setting is "None" or the selected device does not support device specific 
settings, then this button becomes dimmed and disabled. 
 
[Back] button 
Use this button to return to the device selection screen. 
 
[Finish] button 
Use this button to save the current settings to the registry and exit the Add Device 
wizard. 
 
[Chancel] button 
Use this button to stop registering the device and exit the Add Device wizard. 
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Port Setting (Network) 

 
 
Port Setting 
"IP address" edit field 
Use the edit field to specify a network or a wireless device's IP address or host 
name. 
If an IP address or host name is already set up, the address or name appears in 
the edit field. 
 
[Update] button 
The network settings set the input value by pushing the [Update] button. 
If the device that has been set is on the port to be set, depending on the capability 
of the device and selected device, a message not to set the device to the port 
appears. In this case, the port setting is invalid. 
 
"Port is being used by" drop-down list 
Use this drop-down list to display a list of devices that has been already set up for 
the selected port number. 
 
Detailed Setting 
This is the same as the description for "Port Setting(for serial, parallel, or USB) ". 
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Port Setting (TMPORT) 

 
Use this drop-down list to select the TMPORT port to connect to. 
Port Setting  
"Port is being used by" drop-down list 
Use this drop-down list to display a list of devices that has been already set up for 
the selected port number. 
 
[New Port] button 
Use this button to display the Create TMPORT dialog box. 
 
[Update Port] button 
Use this button to display the Create TMPORT dialog box. 
 
"Port is being used by" drop-down list 
Use this drop-down list to display already configured for the selected port number. 
 
Detailed Setting 
This is the same as the description for “Port Setting(for serial, parallel, or 
USB)”.However, in Port Setting (TMPORT), only the items "Baud rate," "Bit 
length," "Parity," "Stop bit," and "Hand shaking" are displayed. 
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3.3.1.4 TMPORT Making 
In this screen, creates a port of TMPORT. 

 

 
"Port type" drop-down list 
Displays a port type that can be created. 
When the "COM", "LPT", or “Bluetooth” is selected: 
Chooses a port in the "Physical port (COM, LPT only)" drop-down list. 
When the "USB" is selected: 
Chooses a device in the "Connect device" drop-down list. 
When the "NET" is selected: 
Inputs an IP address in the "Physical port (NET only)" drop-down list. 
 
"Physical port (COM, LPT only)" drop-down list 
This setting only becomes effective when you select COM, LPT or Bluetooth in the 
"Port type" drop-down list. Only the port recognized by the system is displayed. 
You cannot create a new port at the physical port which has already registered in 
TMPORT. 
When using a Bluetooth device, select the COM port of the Bluetooth device. 
Before registering a Bluetooth-connected device in SetupPOS, configure the COM 
port of the Bluetooth device. Refer to the "Product Manual" for instructions. 
When using the "TM Bluetooth connector Utility," select "COMx." 
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"Physical port (NET only)" edit field  
This setting only becomes effective when you select NET in the "Port type" 
drop-down list. As the default, "0.0.0.0" is displayed. 
You cannot create a new port at the IP address which has already registered in 
TMPORT. 
You cannot specify the host name. 
 
"Connect device (USB only)" drop-down list 
This setting only becomes effective when you select USB in the "Port type" 
drop-down list. The connectable ports are displayed. 
 
"Make Port Name" edit field  
Displays the name of port that is created. 
 

3.4 Using Devices 

This section explains how to set up or delete a device, using POSPrinter TM-T88VIM 
as an example. 

 
3.4.1 Setting up a Device 

To set up POSPrinter TM-T88VI as a device, use the “ Add Device” wizard of 
SetupPOS. 
Start the wizard either by selecting “Add New Device” from the Edit view, or clicking 
the  [ Add Device] button on the tool bar. 

Or, select the POSPrinter in the left pane of the main window, and then right-click to 
bring up a pop-up menu and select Add New Device. (In this case the step starts from 

<Select device screen>.) 
Following the instructions in each screen of the wizard, set up the device as 
described in the following procedure. 

(Operations in each screen) 

[Next] button : Click this button to accept the changes in the current 
screen and then proceed to the next screen. 

[Back] button : Click this button to clear the current settings and go 
back to the previous screen. 

[Cancel] button : Click this button to cancel the operation. 
[Help] button : Click this button to display appropriate help. 

Perform these operations as required in each screen. 
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<Device class selection screen> 
For device class: Select POSPrinter and then click the [Next] button. 

 
<Device selection screen> 

Device : Select "TM-T88VI". 
Connection : "TMPORT" is displayed. 
Name : "TM-T88VI" is displayed. 
Description : "EPSON TM-T88VI POS Printer" is displayed. 
Add New Logical Device Name :If necessary, enter "Unit1." 

(It is possible to enter this information after the 
wizard ends. From the Edit menu, select "Add New 
LDN." Another method is to select a device name 
key and right-click it. From the pop-up menu, select 
"Add New Logical Device Name.") 

Click the [Next] button. 

 

If no assignable ports are available, a dialog box prompting port creation will 
appear. Select the [Yes] button. 

The " TMPORT Making" dialog will then be displayed, where the port type and 
other details can be entered to create the TMPORT. 
 
<Communication settings screen> 
Port Setting  
Select the target TMPORT for the connection. 

If the desired TMPORT is not listed, click the [New Port] button to create a new 
TMPORT. 
 
Detail Setting  

"Setup of details of the port."  * Set the following items. 
BaudRate : 38400 dps 
Bit length : 8 bits 
Parity : NONE 
Stop bit : 1 bit 
Handshake : DTR/DSR 

 

[Interactive CheckHealth] button: 

Click this button and make sure this setting allows for normal communication and 
printing. 

[Device Specific Settings] button: 
If necessary, click this button to change the device specific settings. 
Click the [Finish] button 
The window displays the settings of TM-T88VI. 
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3.3.2 Removing a Device 

Delete a device using one of the following three methods. 

(1) In the main window, select the device name key to be deleted (in this case 
TM-T88VI). From the Edit menu, select Delete. When a confirmation 
message box appears, select Yes to delete the device. 

(2) Select the device name key to be deleted (in this case TM-T88VI). Right-click 
to bring up a pop-up menu and select Delete. When a confirmation message 
box appears, select Yes to delete the device. 

(3) In the main window, select the key of the device name to be deleted (in this 
case TM-T88VI). Then click the [Delete]  icon on the tool bar. When a 
confirmation message box appears, select Yes to delete the device. 
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3.5 Glossary 
Device Class In the Device Class view of the main window, device class is the device 

type displayed below Device. Device classes used in EPSON OPOS 
ADK are as follows:  

CashDrawer, LineDisplay, MICR, CheckScanner, POSPrinter and 
ElectronicJournal. 

For detailed explanations of the devices available, refer to the “OPOS 
Registry Usage” section of the "OPOS Appliccation Programmer's 
Guide ". 

Device Name Key When a device is added, it appears in the Device Class view of the 
main window below device class. If no device is set for the selected 
device class, then this information is not displayed. 
 
For example, the device name key of POSPrinter's TM-295 is 
"POSPrinter¥TM295." 

Logical Device Name 
(LDN) 

An another name used to identify a device. Each device can have a 
logical device name. However, a logical device name which is already 
being used by the same device class cannot be specified. 
 
For example, if a logical device name "Unit1" is already assigned to a 
device called TM-295 of POSPrinter, then "Unit1" cannot be used again 
as a logical device name for TM-88VI in the same device class 
(POSPrinter). Using the logical device names does not need to specify 
the device name key directly and so makes application development 
versatile. 

Registry OPOS uses the system registry to store and reference device 
information. Although it is possible to view the information using the 
REGEDIT utility, do not change the SetupPOS program. For details, 
refer to the “OPOS Registry Usage” section of the "OPOS Appliccation 
Programmer's Guide ". 

Input buffer length It sets the size of the input buffer (unit in bytes; a area in the PC's 
memory for temporarily storing input data). Because this preset value 
has been optimized, usually it is not necessary to modify it. 
If this value is changed smaller than the preset one, the input response 
may deteriorate. On the other hand, if the new value is larger than the 
preset one, input response for large amount of data input would 
improve. Therefore, adjust this value if the input response is bad. 

Output buffer length It sets the size of the output buffer (unit in bytes; a area in the PC's 
memory for temporarily storing output data). Because this preset value 
has been optimized, usually it is not necessary to modify it. 
If this value is changed larger than the preset one, data loss may occur. 
On the other hand, if the new value is smaller than the preset one, the 
output performance may deteriorate. Therefore, unless there is a 
necessary, do not change the preset value. 

Output Interval Time Time interval for retry in the case output fails. If not even 1 byte is 
output for the set time, the Timeout error occurs. While this preset value 
has been optimized, modify it (usually by increasing it rather than 
decreasing it) if the Timeout error frequently occurs during printing at 
your environment. 
On the other hand, timeout errors which occur when communication is 
not possible due to physical problems such as cover being opened are 
normal. Change this value for cases where timeout error occurs during 
printing even though printing is possible. 
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Input Sleep Time During the waiting for input, EPSON OPOS ADK can call Sleep (a 
WIN32 API). The input sleep time is the value (msec) to pass to the 
Sleep function. This preset value has been optimized and usually it 
does not need to be changed. Input processing (ReadFile) uses the 
CPU exclusively. 
When input process is performed while there is no input data in 
particular, because data event does not occur, the application looks like 
it is not running (hangs). To solve this problem, use the Sleep function 
between input processes so that control (of CPU) can be passed to 
other applications as much as possible. (Executing the Sleep function 
passes to other processes.) 
Try to use the preset input sleep time value, because if changing the 
value decreases the input response. To change the input sleep time 
value by all means, change it in a way that strikes a balance between 
input response and application performance. 

Port EPSON OPOS ADK uses the following types of ports: serial(COM), 
parallel(LPT), USB, Ethernet, IEEE802.11., and Bluetooth 

Trace The trace (log) function provides support for application development. 
Usually this function is used only for debugging OPOS applications; it is 
not used for other purposes. To change the trace settings, use the 
“OPOS API trace settings” dialog box. Note that for version 1.xx, the 
trace function can be used only if an EPSON OPOS ADK supporting 
trace is installed. 

Message handling Depending on the application, some methods may require a lot of time 
to process. If the application needs to extract a message during the 
method processing duration, the message handling function is used. Do 
not use this function. 

Sleep time In the programs for waiting for input from device inside the driver or long 
programs which keep the CPU time use exclusively, EPSON OPOS 
ADK can call Sleep (a WIN32 API) to pass control to other programs. 
The input sleep time is the value (msec) to pass to the Sleep function. 
Changing the sleep time changes the ratio of CPU time used by a 
particular device. To change the sleep time for input wait programs, use 
the port detail settings of each device. 

Log file A file for recording the execution result of the trace. 
Primary Device The device for Hydra connection, the host device will be referred to as 

"Primary Device". 
When the Hydra connection: POSPrinter 
When the Pass-through connection: LineDisplay 

Secondary Device The device for Hydra connection, the destination device will be referred 
to as "Secondary Device". 
When the Hydra connection: 

MICR, CheckScanner, ElectronicJournal, LineDisplay, CashDrawer 
When the Pass-through connection: 

POSPrinter, MICR, CheckScanner, ElectronicJournal, CashDrawer 
TMPORT Ports created by OPOS and virtual ports are called TMPORT. 
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Section 4.  Warnings 

4.1 Precautions for Connecting with USB I/F 
 When connecting a new device, turn on the device before running the “ Add 

Device” wizard. The disconnected or power-off devices are not recognized. 
 If the port number of the device is not indicated on the Port Connection View 

screen during the connection, select the corresponding device on the Main View, 
or select [Auto Setting] button on the “Communication Settings” dialog box. The 
connected devices are recognized. 

 When the same type of devices is registered already and some of the devices are 
turned off, there is a possibility that the turned off device's USB port number is 
replaced with the new one. Therefore, beware of registering multiple numbers of 
the same devices. 

 Please note the following points when re-assigning USB ports: 
 Turn on the applicable device when doing automatic USB port setting. 
 If using several devices of the same model on different USB ports, only do 

automatic setting for one device. 
 Editing the registry during automatic USB port setting is not supported. 
 

4.2 Other precautions 
 If an installation is not completed successfully and reinstallation also fails, please 

do the following steps: 
 (1) Uninstall OPOS. 
 (2) Install OPOS version which is originally installed prior to installing this 
 version. 
 (3) Install this version. 

 Version 2.80 or older cannot overwrite Version 3.00 or newer. 
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Section 5.  SetupPOS Utility 

About the ‘JSON for Modern C++’ License 
 
The SetupPOS utility includes ‘JSON for Modern C++’. 

------------------------------------------------------------------------ 

MIT License  

 

Copyright (c) 2013-2022 Niels Lohmann 

 

Permission is hereby granted, free of charge, to any person obtaining a copy 

of this software and associated documentation files (the "Software"), to deal 

in the Software without restriction, including without limitation the rights 

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 

copies of the Software, and to permit persons to whom the Software is 

furnished to do so, subject to the following conditions: 

 

The above copyright notice and this permission notice shall be included in all 

copies or substantial portions of the Software. 

 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 

IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 

FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE 

AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER 

LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, 

OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 

SOFTWARE. 
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